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Notes about Operation
f This product has been designed for use in normal living conditions, and is not suited
!

for controlled environments such as a CO2 incubator. When measuring outdoors,
avoid exposure to sunlight, dust, rain, or wind. Also make sure to use in the operating
environment indicated in the specifications.

This product cannot measure CO or O2. Do not use the unit for purposes such as
e \ avoiding O2 deficiency, CO intoxication or any other health related purpose.

For one to two weeks after installation of the TR-76Ui, CO2 concentration
measurements may fluctuate suddenly. This is due to the normal operation of Auto
Calibration and is not a malfunction of the unit.

Do not use or store the unit in areas exposed to direct sunlight and abrupt changes
in temperature.

Do not allow the unit to become wet. Do not use or store the unit in places where
condensation occurs.

To help prevent deterioration of the unit, do not use or store the unit in areas
exposed to cigarette smoke, corrosive, explosive or organic gases or dust in the air.

Do not expose the unit to a strong impact. This will adversely affect measurement
accuracy and may cause the case to break resulting in bodily injury.

The measurement accuracy of the CO2 sensor can not be guaranteed for CO2
concentrations of 5,000ppm or more.

The Warning Monitoring function provided in the TR-76Ui is for informational
purposes only. By clicking “I Agree” button you confirm your understanding that itis
not to be relied upon for human health or safety.
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Part Names and LCD Display
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(@ CO2 Sensor Area (Internal)

(@ LCD Display

® Infrared Communication Port

(@ Operation Buttons
(DISPLAY) Button
(INTERVAL ) Button
{REC/STOP) Button

® Battery Cover

® Temperature and Humidity Sensor Jack

@ AC Adaptor Jack

USB Communication Cable Jack

(© Serial Communication Cable Jack (RS-232C)
External Alarm Terminal (EXT ALM)

@ (POWER) Switch
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© [REC] Mark Shows recording status

ON: Recording in progress

BLINKING: Waiting for programmed start

OFF: Recording stopped

At the beginning of every 2,000 readings the scale will be marked from left to
right. Logging capacity is 8,000 readings.

Shows communication status but not displayed normally.

ON: The unit is connected to a PC with a USB cable.

RAPID BLINKING: The unit is in communication with the computer via USB or
infrared communication.

@ Data Scale

© [COM] Mark

Recording

Recording mode settings can be made by using the supplied software.

Mode
Endless: Upon reaching the logging capacity of 8,000 readings, the oldest data will be
overwritten and recording will continue.
One Time: Upon reaching the logging capacity of 8,000 readings, recording will

automatically stop and in the LCD the current measurement and the word
“FULL" will alternately appear.
@ Battery Mark Shows source of power and voltage level
ON: Running on external power source
BLINKING: Running on battery power
OFF: No battery
Current Shows the current readings for temperature ( °C or °F) and humidity (%RH).
Temperature Pressing the (DISPLAY) button will change the measurement item to be

and Humidity displayed. By using the supplied software, the unit of temperature can be
Readings Area changed. is also used to display messages.

@ Current CO2  shows the current readings for CO2 concentration (ppm). is also used to
Readings Area display messages.

Messages and Display on the LCD

Settings Messages

- Button Lock
,‘ When "Button Lock" has been set to ON in
- CO2 Recorder for Windows, operational buttons are not active.
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@R ow @@ Memory Full

When recording mode has been set to “One Time” and the unit
Sl ) reaches its logging capacity of 8,000 readings, the measurement
oL L and the message [FULL] will alternately appear in the LCD.

Stop recording and download the recorded data before
re-starting recording.

* When this happens, measurement will continue so battery power will be consumed.
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Button Operations

A Upon the start of recording, all previously recorded data in the TR-76Ui will be deleted.

If "Button Lock" has been set to ON in the CO2 Recorder for Windows, the operational
buttons will not be active.

(REC/STOP) Button: Starting and Stopping Recording
Starting Recording

o) T

Press the (REC/STOP) button for about two seconds until the b |
: L Lic
[REC] mark appears on the display. Y e T
« It is possible to start recording even while waiting for a T

programmed recording to start.
Stopping Recording

Press the (REC/STOP) button for about two seconds until the e ,: :, ,‘:,'
[REC] mark disappears from the display. ““‘_""_'é’oz
L™

(DISPLAY ) Button: Changing the LCD Display Pattern

It is possible to change the current readings display for temperature and

humidity (upper row). CO2 concentration (lower row) is always displayed.

1. With each pressing of the (DISPLAY) button the item on the display will change.
Temperature and Humidity: The display will alternate every one second.

Temperature only

Humidity only

2. When the desired display pattern appears, stop pressing the button.

(INTERVAL ) Button: Checking Recording Interval

It is possible to check the recording interval during recording or while waiting
for a programmed recording to start.

1- By pressing the < |NTERVAL> button 10 minutes 10 seconds
for about two seconds, the currently s TTTam s TTTam
set recording interval will appear on
the LCD display. " 1"
. , IL. . I
2. If no operation is carried out after

the recording interval has been
displayed, the current
measurement readings will return
to the LCD display.

(INTERVAL ) Button: Changing the Recording Interval Setting

Recording interval settings cannot be changed while a recording session is in
progress.

1. Stop recording.

2. Press the (INTERVAL) button for about two seconds to display the currently
set recording interval on the LCD screen.

3. With each pressing of the (INTERVAL ) button the recording interval time will
change; stop pressing the button when the desired interval appears.

4. Restart the recording session.

When [-—--] appears in the following:

@R o

Temperature and Humidity Display Area
This appears when the temperature-humidity sensor is not
connected to the TR-76Ui, the connection is loose, the wire is
broken, or when power has just been turned ON. If after
re-connecting the sensor, measurements can still not be
displayed, it is very possible that the sensor or the logger is
defective or has been damaged.

@z ~===c3| (02 Concentration Display Area
,-' '-,','- . This appears when power has just been turned ON. If

co2 measurements don't appear in the display after waiting for a
considerable time, there is a possibility that the sensor is
defective or has been damaged. Also, the CO2 sensor will not
work if battery power is low.

* Measurement and recording will continue in this situation, so battery power will be consumed.
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Setting up the TR-76Ui

A Make sure to install the provided software before connecting the TR-76Ui to your PC.

Connect the Temperature and Humidity Sensor

Turn On the Power

AC Adaptor

When measuring and recording over long periods of
time, please use a supplied AC adaptor.

Four AA Alkaline Batteries

Keeping batteries in the unit allows a backup source of
power * for when and if electrical power is cut from
the AC adaptor. If running on only batteries, the
estimated battery life is about two days.

* Leaving alkaline batteries in the unit for a long period of time may cause battery leakage and
corrosion. When using as a backup source, we recommend that you change the batteries every
few years.

Turn On the (POWER ) Switch

After setting up the power supply, turn on the (POWER)
Switch.

Warm-up Time for CO2 Sensor

After switching on the unit, it will take about one minute to display the
normal CO2 concentration.

Install the Batteries

If battery power is lost, all recorded data stored in the unit will be erased. Do not leave
the unit without batteries.

1. Remove the battery cover from the back
of the unit.

@ While pressing down on the triangular mark,
slide the cover to the bottom of the unit.

@ Lift off the cover.

2. Insert the batteries.
* Make sure to use four new batteries of the same
kind.
* Make sure not to mistake +/ -.
* Do not insert or change batteries with wet hands.
* Be sure to completely close the cover.

.
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Interpreting the Battery Mark

Checking the Power Supply Condition
Whether the battery mark is "blinking" or "on" indicates the source of power.

Mark blinks when running on
battery power.

BLINKING (Running on battery):

The battery mark will blink on the LCD display when measuring and
recording by battery power.

ON (Running on external power):

The battery mark will be on when measuring and recording by AC
adaptor power.

Checking the Battery Level
The battery level will be shown in three stages as below.

D@ Battery Power - OK @ [@rz _em)

@_® Battery Power - Getting Low ,_":,','_’,'c
Please change the batteries as soon as possible. l.,l,l',l,l',l,‘,’,?.f,

®1__4 Battery Power - Too Low Q [@EE s
Battery power is too low to carry out measurement ,-' L",‘.,“c
and recording of CO2 concentration. - coz

« When running on batteries only, it will take about 24 hours to go from Stage @ to @ and
another 24 hours from Stage @ to ®.

@ Sleep Mode (stopping measurement and recording) @ _ 43
After Stage (3, if the battery is not changed but it remains in use, '-”' ,’-’
the unit will enter sleep mode and stop measurement and ==
recording in order to protect recorded data until this point.

* To continue recording, it is necessary to change the batteries
before the unit enters sleep mode.

« If the unit is already in sleep mode, download the recorded data
into the PC before re-starting recording.

® Erasing recorded data ®
If the battery is further left unchanged, the display will
automatically shut off and all previously recorded data will be lost.

Removing the Batteries during Recording

1. If the batteries are removed when running on e

battery power only, the unit will start a sixty- 1)
( }——Countdown
3

second countdown.

2. To continue recording, before the countdown
comes to an end, insert new batteries or connect
the AC adaptor to supply power.

3. If power is not supplied within 60 seconds, the unit _
will enter sleep mode. L”‘ ,'.'

Turning Off the (POWER ) Switch

During recording or when the "Button Lock" is set to ON in the
CO2 Recorder for Windows, the power cannot be turned off even by pressing the
(POWER ) Switch.

1. Stop recording.
2. Turn off the (POWER ) Switch.

Standby Power

If the TR-76Ui is connected to an AC adaptor, standby power will be supplied
even after turning off the (POWER ) switch, allowing the CO2 sensor to con-
tinue operation.

J

Notes on Special Functions

Getting Ready for Using Infrared Communication

In order to download recorded data from the TR-76Ui via infrared
communication, it is necessary to purchase the dedicated Data Collector
TR-57DCi (sold separately).

+ Go to [ 29 Operation Guide] to see how to download data via data collector.

Getting Ready for Using the Warning Monitoring
Function

It is possible to connect an external device such as siren or lamp to the
TR-76Ui. Please make sure to check specification details of the external alarm
terminal before purchasing or getting an external device ready for connection.

Upper and Lower Limit Settings

To use the warning monitoring function, go to the [Start Recording] tab in
the CO2 Recorder for Windows and make settings for Upper and Lower
Limits and Judgment Time. When the measurement exceeds one of the set
upper and lower limits, the TR-76Ui will turn ON the external alarm terminal.
Upon a warning, the measurement value on the display will also flash.

.

About the External Alarm Terminal (EXT ALM)

@ Warning Output |Internal Pull-up: 3V 100kQ
(Enable / Disable) |Maximum Input Voltage: 30V

® |GND

Enabling
Warnings

Open Drain Output
Voltage when OFF: DC less than 30V
Current when ON: less than 0.1A

Output Terminal
Warning Output @ |(Warning

®OEO
L

EXT ALM

(ouT) Output) Resistance when ON: 15Q
@ |GND
The connection between (D and @ decides whether Warning D—
Output is enabled or disabled. @—
If a warning condition occurs while Warning Output is Enabled Disabled

enabled, a connection between 3 and @ will be established
and a warning will be output.

Alarm Connection Cable

The optional alarm connection cable (AC0101) is available. Please contact
your local distributor for purchase.

Distributor List  https://tandd.com/purchasing/
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Using the Software

A Do not connect a TR-76Ui to your computer until the software has been installed.

Specifications

@ Install the Software

For installation of the supplied software, it is necessary to have Administrator (Computer
Administrator) rights.

1. start Windows and place the CD-ROM into your CD or DVD drive.
2. In a few seconds, the [Install Program] window will appear.

+ If the [Auto Play] window appears, click on
[Run start.exe].

« If the [Install Program] window does not
automatically open, please open it by double
clicking on the [start.exe] icon in your CD or
DVD drive.

3. Select “Install CO2 Recorder for Windows” and click the [Execute] button to
start the installation. Follow the directions to install.

O

4. 1f a window appears such as the one below during installation, click the [Install]
button.

-

5. After installation, "CO2 Recorder for Windows" will appear in the Windows Start
Screen or Start Menu.

@ Connect the TR-76Ui to a PC

1. Connect the device with the supplied USB cable to your computer.
The USB driver installation will start automatically.
« It is not necessary to connect AC adaptor at this point.

2. Open CO2 Recorder for Windows and confirm that the TR-76Ui icon appears in
the main window.

« If the icon does not appear, please check whether the USB driver has been properly installed.
(Refer to [E? Help for Unit Recognition Failure] )

@ Make Atmospheric Pressure Correction Settings

Measurement results of CO2 concentration are affected by atmospheric
pressure. When high measurement accuracy is required, we recommend
that Atmospheric Pressure Correction be carried out before a recording
session is started.

1. Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.

2. From the [Settings] Menu, select [Atmospheric Pressure Correction] to open
the settings window.

N

Enter Atmospheric Pressure at Measurement
Location:

Directly enter the pressure (hpa) in the
[Atmospheric Pressure] field.

Calculate Atmospheric Pressure from
Altitude:

This setting can also be made by having the
software calculate the estimated pressure at the
altitude (meters) entered by the user.

3. Click the [Send Settings] button to transmit the settings to the TR-76Ui.

@ Make Settings and Start Recording

A Upon the start of recording, all previously recorded data in the TR-76Ui will be deleted.

1. Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.

\.

| TR-76Ui | TR-76Ui-S
Temperature-Humidity Sensor (External)
\ sensor THA-3001 SHA-3151(High-Precision Type)
: : : H H Thermistor Polymer Resistance Thermistor Polymer Resistance
2. I[\g?aki rReeCCOOrrd(;Irr\-]gg]Siggnvgligowe Q Prlntl_ng the G raph . . gﬂﬁ:ﬁgglesment Temperature 1ch Humidity 1ch Temperature 1ch Humidity 1ch
’ 1. While the graph is open, make any desired adjustments to the graph Gnits of
3. Click the [Start Recording] button enlargement, position and aspect ratio to be reflected in the printed graph. Measurement C.°F ¥oRH C°F %oRH
to transmit the settings to the g”::;:;z;';e”t 0t055°C 10 to 95 %RH -25t070 °C 0 to 99 %RH (*2)
TR-76Ui. +0.3°C
. +5 %RH at 10 to 40 °C +2.5 %RH
Accuracy 0.5°C at25°C S0%RH | *92°C at 15 to 35 °C, 30 to 80 %RH
temperatures
Measurement 0.1°C 1 %RH 0.1°C 0.1 %RH
4' Disconnect the TR-76Ui from the PC and place in the desired measurement Responsiveness Response Time (90%): Approx. 7 min. Response Time (90%): Approx. 7 min.

location.

Recording Settings

Recording Start Date and Time

Programmed Start: Recording will begin on the set date and time. As the current date and time
of your computer are used, make sure that your computer clock settings are
correct.

Immediate Start: Recording will start when the [Start Recording] button is clicked.

Recording Mode
One Time: Upon reaching the logging capacity of 8,000 readings, recording will automatically stop.

Endless: Upon reaching the logging capacity of 8,000 readings, the oldest data will be
overwritten and recording will continue.

Recording Interval
There are 15 choices for the recording interval.
Below are some examples of recording interval and maximum recording time.

1 second (2 hr 13 min 20 sec) 10 minutes (55 days 13 hr 20 min 00 sec)
30 seconds (2 days 18 hr 40 min 00 sec) 15 minutes (83 days 8 hr 00 min 00 sec)

1 minute (5 days 13 hr 20 min 00 sec) 30 minutes (166 days 16 hr 00 min 00 sec)
5 minutes (27 days 18 hr 40 min 00 sec) 60 minutes (333 days 8 hr 00 min 00 sec)

@ Download Recorded Data to a PC

A Even after downloading recorded data, the data will remain in the TR-76Ui.

1. Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.
2. In the [Download Recorded Data] tab window, click the [Download] button.

>

Here you can check the storage location
and file name for the recorded data.

3. When a completion message appears after downloading, click the [OK] button
to view the graph for that data.

Storage Location of Recorded Data and File Name (Default Settings)
Documents (or My Documents)\TandD Corp\CO2 Recorder for Windows\Serial
No.(folder)\Serial No.*+ Downloading Date and Time.thc

*Serial No. can be found on the sticker attached to the logger.

€02 Recorder
TR-76U¢

@ View and Print Graphs

Viewing Saved Data in Graph Form
1. Open T&D Graph.
2. From the [File] menu, click [Open].

3. Select the desired file, and click the [Open] button to view the graph for that
data.

* Graphs will be printed using the resolution and aspect ratio settings made for the Graph
Display Area in Step 1 above. If you wish to change the resolution and/or aspect ratio, go back
to Step 1 and make further adjustments based on the preview image.

2. From the [File] menu, click [Print Graph].

3. By selecting the options on the toolbar in the Print Preview window, you can
adjust the paper orientation, margin, items to be printed, etc.
The graph title, items to be printed, and margin can be set in [Page Setup].

4. Click the [Print] button.
« For operational details of the T&D Graph, refer to the software Help.

Opening Data using Spreadsheet Software

It is possible to convert recorded data to a text file (CSV format) which can
be read by common spreadsheet software.

1. While the graph is open, click [Save in CSV Format] in the [File] menu.

2. Specify the storage location, file name, and file type, then click the [Save]
button.

* For operational details of the spreadsheet software, refer to the software manual or help.

a )
Auto Calibration Function for CO2 Sensor

What is "Auto Calibration" ?

Auto calibration is a function designed to enable long-term accurate
measurements for the TR-76Ui by gradually adjusting the lowest measured
CO2 concentration over a 180 hour period, to the global average
concentration (atmospheric CO2 level of 390 ppm).

* The factory default setting for auto calibration is ON.

Turning ON and OFF Auto Calibration

Turn off auto calibration (*1) when continuously measuring in an
environment where the lowest CO2 concentration differs greatly from the
global average concentration of 390 ppm.
In this case, to ensure accurate measurement results, periodically place the
TR-76Ui in fresh air outside and check if the measured CO2 concentration
values are close to 390 ppm or not. If not, we recommend that you carry
out manual calibration (*2).

*1: The factory default setting for auto calibration is enabled. To change this setting, go to the

[Settings] menu and select [Auto Calibration Settings].

*2: The measurement of the CO2 sensor may have a slow drift. It is recommended to perform
manual calibration about once a month. For details about manual calibration, please refer to
[TR-76Ui Operation Guide]- [Available Settings] .

\ _/

~ > ™\
E< For more detailed information

Operation Guide:
Operation Guide contains detailed information about basic settings as well as details
about advanced settings for many useful functions. Access if from the Start Screen/
Menu or from the [Help] button in the application window.

Help for Unit Recognition Failure:
[Help for Unit Recognition Failure] contains detailed information about installing and
checking the USB driver as mentioned in [Using the Software : STEPZ]. Access is via
the [Help] menu in CO2 Recorder for Windows.

| 5

CO2 Sensor (Internal)

Sensor NDIR
Measurement CO2 Concentration 1ch
Channels

Units of Measurement | ppm

Measurement Range | 0 to 9,999 ppm

Accuracy +(50 ppm + 5 % of reading) at 5,000 ppm or less (*3)
Measurement Minimum of 1 ppm
Resolution pp

Responsiveness Response Time (90%): Approx. 1 min.

Unit Specifications

Logging Capacity 8,000 data sets (One data set consists of readings for all channels in that type of unit.)

Recording Interval Select from 15 choices: 1, 2, 5, 10, 15, 20, 30 sec. or 1, 2, 5, 10, 15, 20, 30, 60 min.

Recording Mode fELr:IgIess (Overwrite oldest data when capacity is full) or One Time (Stop recording when capacity is

USB Communication
Infrared Communication: IrPHY 1.2 low power (*4)
Serial Communication: RS-232C (*5)

Communication
Interfaces

External Alarm
Terminal (*6)

Output Terminal: Open Drain Output (Voltage when OFF: DC less than 30V / Current when ON: less
than 0.1A / Resistance when ON: about 15Q)

Power AC Adaptor (AD-06A1 or AD-06C1), AA Alkaline LR6 Battery x 4

Battery Life Approx. 2 days ( batteries only without AC adaptor ) (*7)

Dimensions H 96 mm x W 66 mm x D 46 mm ( excluding protrusions and sensor )
Weight Approx. 120 g
Operating

Environment Temperature: 0 to 45 °C, Humidity: 90 %RH or less ( no condensation )

Initial Settings Recording Mode: Endless, Recording Interval: 10 min.

CO2 Recorder for Windows

Microsoft Windows 10 32/64 bit
Microsoft Windows 8 32/64 bit
Microsoft Windows 7 32/64 bit

Compatible OS (*8)

Display Languages (*9) | English

*1: Make sure to use the data logger within the operating environment as listed in the specifications.

*2: When continually used in environments with temperatures above 60°C, accuracy of humidity measurements will decrease
over time. Also, humidity cannot be measured at temperatures below -20°C.

*3: Stated value is the measurement accuracy of the CO2 sensor when Auto Calibration is operating properly. A change in
atmospheric pressure directly influences the reading of CO2, which can cause measurement errors; a decrease in pressure
by 10 hPa results in a relative decrease in CO2 by 1.6%. In such a case, we recommend carrying out the “Atmospheric
Pressure Correction” function found in CO2 Recorder for Windows.

*4: If you wish to use infrared communication to download recorded data, it is necessary to purchase the Data Collector TR-
57DCi (sold separately).

*5: Customers wishing to write their own software, please contact your local distributor for the serial communications protocol
specifications. (Note: Optional serial communication cable TR-07C is also required.)

*6: In order to use the external alarm terminal, please purchase the optional alarm connection cable (AC0101).

*7: Battery life varies depending upon the ambient temperature in which it is used, the recording interval, the frequency of
communication, and the battery performance. All estimates are based on operations carried out with a new battery and are
in no way a guarantee of actual battery life. Battery life may be shortened if the unit is used under inverter type fluorescent
lighting.

*8: For installation, it is necessary to have Administrator (Computer Administrator) rights.

*9: We recommend using an operating system in the same language as the display language. Operation in different languages
is not guaranteed.

The specifications listed above are subject to change without notice.

Cautions about using the Temperature-Humidity Sensors

- If extremely severe temperature changes occur, the humidity measurements may appear abnormal.
Once the sensor’s temperature becomes stable, the measurements will return to normal.

- Do not connect the sensor to any data logger other than those specified by T&D Corporation.

- Do not expose the sensor to a strong impact. This may adversely affect measurement accuracy and
cause damage or malfunction.

- When the sensor is not to be used for a long period of time, please store it at normal temperature and
humidity.

- Do not allow the sensor to become wet. If the sensor gets wet, immediately remove it from the unit.

- Do not use the sensor on the human body.

- Do not expose to condensation, dampness, corrosive gases, or organic solvents.

- Continued use may cause a decrease in the sensor’s accuracy and sensitivity even under normal
operational conditions. If the sensor is being used in a bad environment (smoky or dusty places) it may
be necessary to change the sensor sooner.

- The SHA-3151 is not water resistant. If the sensor gets wet, immediately remove the sensor from the
unit and wipe it with a clean cloth as soon as possible. Then allow the sensor to dry in normal room
temperature before using it again.

- When using the THA-3001/3151 in an environment where the humidity is under 30%RH, the
measurements may sometimes fluctuate. This is not abnormal.

A

Options

Data Collector: TR-57DCi Wall Attachment: AT-76K1

For Infrared Communication Material: Aluminum

Accessories

USB Communication Cable (US-15C)
Serial Communication Cable (TR-6C10)
AAA Alkaline Battery x 2

Software CD-ROM

Sensor Extension Cable: TR-1C30
3151

IR 5 D

Measurement Range:

Temperature: 0 to 55 °C / Humidity 10 to 95 %RH (No
condensation)

Cable Length: 1.5 m

For Temperature-Humidity Sensor THA-3001/3151, SHA-3151
(Possible to use up to three extension cables per sensor)
Cable Length: 3m

Temperature Durability: -25 to 60 °C

Material: Vinyl Coated Electrical Wire



